USING MICROSOFT® LYNC®

USER’S GUIDE

MARCH 2015
© 2015 UNIVERSITY OF SOUTHERN CALIFORNIA. All rights reserved.

This manual, as well as the data and software implementation described in it, is furnished under license and may be used or copied only in accordance with the terms of such license. The content of this manual is furnished for informational use only, is subject to change without notice, and should not be construed as a commitment on the part of the University of Southern California.

Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without the prior written permission of the University of Southern California.

The data and software implementation, as with all technical and computer-aided design software, is a tool intended to be used by trained professionals only. The data and the software implementation is not a substitute for the professional judgment of trained professionals. The software implementation is intended to assist with product design and is not a substitute for independent testing of product stress, safety and utility. The University of Southern California assumes no liability for any error or inaccuracies that may appear in this manual. The University of Southern California makes no warranties with respect to this manual and disclaims any implied warranties of merchantability and fitness for a particular purpose.

U.S. Government Customers:

The Products are provided to the Federal government and its agency with RESTRICTED RIGHTS. USE, DUPLICATION OR DISCLOSURE BY THE GOVERNMENT IS SUBJECT TO RESTRICTIONS SET FORTH IN SUB-PARAGRAPH (c)(1)(ii) OF THE RIGHTS IN TECHNICAL DATA AND COMPUTER SOFTWARE CLAUSE AT DFARS 252.227-7013 OR SUB-PARAGRAPHS (c)(1) OR (2) OF THE COMMERCIAL COMPUTER SOFTWARE-RESTRICTED RIGHTS AT 48 CFR 52.227-19, AS APPLICABLE.
# TABLE OF CONTENTS

Chapter 1: Navigating Lync ........................................................................................................................................ 4
  Interface Basics ................................................................................................................................................... 4
  Status Message .................................................................................................................................................. 6
  Status Menu .................................................................................................................................................... 8
  Set Your Location Menu .............................................................................................................................. 9
  The Options Menu .......................................................................................................................................... 10

Chapter 2: Working with Lync Contacts ........................................................................................................ 13
  Viewing and Adding Contacts ...................................................................................................................... 13
  Creating a Contact Group ............................................................................................................................. 18

Chapter 3: Sending a Message ...................................................................................................................... 21
  Sending a Message......................................................................................................................................... 21

Chapter 4: The Message Window ............................................................................................................... 22

Chapter 5: Lync Options Menu .................................................................................................................. 24
  Configuring Lync ............................................................................................................................................ 24
  The General Settings .................................................................................................................................... 25
  The Personal Settings .................................................................................................................................. 31
  The Contacts List Settings .......................................................................................................................... 36
  The Status Settings ..................................................................................................................................... 39
  My Picture Settings ...................................................................................................................................... 41
  The Phones Settings .................................................................................................................................... 44
  The Alerts Settings ....................................................................................................................................... 48
  The Ringtones and Sounds Settings ........................................................................................................... 51
  The Audio Device Settings ........................................................................................................................ 54
  The Video Device Settings ........................................................................................................................ 57
  The File Saving Settings ............................................................................................................................ 61
  The Recordings Settings ............................................................................................................................. 62
  The Lync Meetings Settings ....................................................................................................................... 64

Chapter 6: Presentation Tools Within Lync ................................................................................................ 67
  Presentation Tools ......................................................................................................................................... 67
  Using the Whiteboard .................................................................................................................................. 69
  Creating a Poll ............................................................................................................................................... 71

Chapter 7: Lync Recording Manager ......................................................................................................... 73

Contact Dornsife Technology Services ....................................................................................................... 75
This topic explains how to use the Microsoft® Lync® interface. Use this topic to assist you in navigating the interface.

**Interface Basics**
The Lync interface contains several symbols and options to assist your use of Lync. This topic explains those symbols and fields.

**Lync Symbol**
At the top, left of the Lync window, a Lync symbol is displayed. This is the same symbol that is displayed in the task bar when Lync is running. Select the Lync symbol within the Lync window.

Select the **Lync** symbol to display the traditional Windows® File menu. Make the appropriate selection from the menu. Repeat these steps to re-display the **File** menu.
CHAPTER 1: NAVIGATING LYNC

Contacts, Meetings, and Conversations
The upper portion of the Lync window contains several different symbols that, when selected, will quickly open a different part of the Lync application.

The highlighted symbols correspond to the following actions/areas of Lync.

- **Contacts**: The **Contacts** symbol ( ) provides the ability to quickly access your contacts list when working in another area of the application.

- **Conversations**: The **Conversations** symbol ( ) displays all of the conversations you have conducted in Lync. Unless otherwise configured, Lync will retain a log of these conversations that can be accessed at anytime by selecting the **Conversations** symbol.

- **Meetings**: The **Meetings** symbol ( ), when selected, displays a listing of all the meetings on your Outlook calendar for the day. This provides the ability to quickly view your agenda for the day, without leaving the Lync window.

- **Options**: The **Options** symbol ( ) displays the settings within Lync that you have the ability to customize. This screen and the settings are covered in a separate topic.
• **Add a Contact:** The Add a Contact symbol (🔗) provides the ability to add a contact from the Contact List within Lync.

The last symbol within the Lync interface is the **Select Your Primary Device** symbol. This symbol, located at the bottom of the screen, displays a drop-down menu, when selected. From this menu, you may select the primary microphone and speakers to be used with Lync. Selecting an option from this menu is not required.

**Status Message**

The status field provides the ability to enter a message or thought to Lync. For example, you might add an informative message, like "out of town between the 18th and 20th," or a greeting, such as "Happy Valentine's Day!"
To enter a status message, place your cursor in the status field and begin typing the message you want to appear next to your name on Lync. When you have finished entering the text, press the Enter key. The message is now displayed next to your name on Lync. An example is shown below.
**CHAPTER 1: NAVIGATING LYNC**

**Status Menu**

Lync provides the ability to manually select a status. Your status indicates if you are available to collaborate and chat with others, or if you are busy or in a meeting. Lync can sync with Microsoft Outlook® and automatically change your status to correspond to calendar events. To manually set your status, select the **Status** drop-down menu. An example is shown below.

From the drop-down menu, you can select the appropriate status for your current state. The default status is **Available**. If you do not select a status or you choose the **Reset Status**, **Available** will be the status that is displayed. The status you select also determines whether or not you receive messages at certain times. For example, if you select a status of **Do Not Disturb**, depending on your settings, you may not receive messages while your status is set to Do Not Disturb.

Select the appropriate status for your current state. The status indicator next to your name will change to the corresponding status color, as shown below.

Repeat this process to change your status.
Set Your Location Menu
The **Set Your Location** menu provides the ability to display the location from which you are presently working. For example, if you work from multiple locations, you may want to alert your contacts to your present location. Select the **Set Your Location** menu, as shown below.

The **Set Your Location** field becomes a text field in which you can type. Enter the text you want to display as your main location.

Press the **Enter** or **Tab** key on your keyboard to save the location information you typed.

Multiple custom locations are not saved within Lync. If you update your location, the previous location is removed. Repeat these steps to display a custom location.
The Options Menu

The *Options* menu contains two different menu sets. When the gear (⚙️) icon is selected, the *Options* menu displays. An example is shown below.

![Options Menu Example](image1.png)

When the downward pointing arrow that is on the right side of the gear icon is selected, a pop-up menu is displayed. An example is shown below.

![Pop-up Menu Example](image2.png)

There are five (5) menu options displayed within the pop-up menu. With the exception of the *Meet Now* and *Show Menu Bar* options, all options contain a sub-menu.

The File Menu
The File menu contains several options to enable you to quickly perform actions within Lync. A description of those options is below.

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sign Out</td>
<td>Use this option to sign out of Lync. This option will only sign you out of the Lync network. It will not exit the Lync program.</td>
</tr>
<tr>
<td>Change Sign-In Address...</td>
<td>Select this option to change the stored e-mail address with which you sign into Lync.</td>
</tr>
<tr>
<td>My Status</td>
<td>Select this option to display the Lync Status Menu.</td>
</tr>
<tr>
<td>View Received Files</td>
<td>Select this option to view the files you have received within Lync.</td>
</tr>
<tr>
<td>View Conversation History</td>
<td>Select this option to launch Microsoft Outlook and display the Conversation History folder. This option is only valid if you have selected to save a copy of your Lync conversations to this folder.</td>
</tr>
<tr>
<td>Close</td>
<td>Select this option to close and minimize the Lync window.</td>
</tr>
<tr>
<td>Exit</td>
<td>Select this option to completely exit the Lync application.</td>
</tr>
</tbody>
</table>

Utilize these options as is appropriate.

**The Meet Now Option**

The Meet Now option within the Options pop-up menu launches a meeting when selected. You can provide the meeting information (located by accessing More Options > Meeting Entry Info) to other individuals that you want to join your meeting session.
CHAPTER 1: NAVIGATING LYNC

The Tools Menu Option

The Tools menu contains several options to related to setting configuration within Lync. A description of those options is below.

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always on Top</td>
<td>If you Lync to always appear on top of other windows, select this option.</td>
</tr>
<tr>
<td>Recording Manager</td>
<td>Select this option to launch the Recording Manager.</td>
</tr>
<tr>
<td>Audio Device Settings</td>
<td>Select this option to open the Audio Device Settings.</td>
</tr>
<tr>
<td>Video Device Settings</td>
<td>Select this option to open the Video Device Settings.</td>
</tr>
<tr>
<td>Dial-in Conferencing Settings</td>
<td>Select this option to view the conference settings if you cannot use the audio conferencing within Lync. This information could also be used by non-Lync users to dial into a meeting session.</td>
</tr>
<tr>
<td>Options</td>
<td>Select this option to display the Options settings.</td>
</tr>
</tbody>
</table>

Utilize these options as is appropriate.

The Help Menu

Select the Help option to display the Microsoft-authored help topics and documents.

Show Menu Bar

Select the Show Menu Bar option to display the menu bar at the top of the Lync window. The menu that is displayed when this option is selected is the same that is available from the Options pop-up menu.

Use this topic to assist you when using the Options pop-up menu.
Your Contact List is the location from which you can interact with your contacts. You can send them a message, add them to groups, and decide how you want the contacts displayed within Lync. This topic details how to work with your Contact List in Lync.

**Viewing and Adding Contacts**

Viewing and adding contacts to your Lync list is simple. There are several ways through which you can add contacts to your Contact List. The most direct method is described in this topic.

After logging into Lync, Lync is displayed and appears similar to the following image.

Select the **Add a Contact** icon.
Select the **Add a Contact** icon, located on the right side of the **Lync** window. A drop-down menu displays.

The drop-down menu provides several options. You can:

- **Add a Contact in My Organization**: Use this option to add a contact that works for the same company/organization as you.
- **Add a Contact Not in My Organization**: Use this option to add a Lync user that does not work for the same company/organization as you.
- **Create a New Group**: Select this option to organize your contacts into Groups.
- **Display Options**: Select this option to customize your display.
For the purposes of this document, the **Add a Contact in My Organization** option will be selected. After selecting **Add a Contact in My Organization**, the cursor is moved from its current position and placed into the **Find Someone** field, as shown below.
Begin typing the name of the person you want to add as a contact. As you enter characters into the **Find Someone** field, the results are narrowed to alphabetical matches.
Continue entering characters until you locate the name of the person you want to add to your contacts. Once the name of the person you want to add to your contacts is displayed, right-click on the person's name. A pop-up menu displays.

Select the **Add to Contacts List** option. A sub-menu displays to the right of the original pop-up menu. The sub-menu displays your contact groups. By default, you have an *Other Contacts* group. If you have created any other contact groups, the names of those groups are displayed. Select the name of the group to which you want to add this contact. After selecting a group name, the contact is added to your contact list, in the selected group.

Repeat these steps to add additional contacts to your Contact List.
Creating a Contact Group

Contact groups provide the ability to organize your Lync contacts by an association, such as the department in which they work. Follow these steps to create a new Contact group within Lync.

Log into Lync and select the **Add a Contact** icon, located on the right side of the *Lync* window. A drop-down menu displays.
From the drop-down menu, select **Create a New Group**. A new field in which you can enter the name of your new contact group is displayed.
Place your cursor in the **New Group** field and begin typing the name of the contact group you are creating. When you are finished entering the contact group name, press the **Enter** key. The contact group is now displayed in the list of available groups.

Repeat these steps to create additional contact groups.
CHAPTER 3: SENDING A MESSAGE

Sending a message within Lync is simple. It's also an efficient way to communicate with other department or organization members.

Sending a Message
To send a message, first log into Lync. Your Lync Contact List displays. Right-click with your mouse on the name of a contact. A message window displays.

Type the message you want to send to this contact and then press the Enter key on your keyboard. The message is sent to the contact.

Repeat these steps to send additional messages.
The message window within Lync is easy-to-navigate and provides you with several options and contact methods.

Right-click the name of a contact to launch a message window.

The message window contains buttons and icons with which you can interact to perform specific actions.
CHAPTER 5: LYNC OPTIONS MENU

In the message text area, there are three options:

- **Font**: Select the Font (A) icon to change the font with which your IM is written.
- **Choose a Smiley**: Select the Choose a Smiley (😊) icon to insert an emoticon into the IM you are composing.
- **Set high importance for this message**: Select the High Importance (!) icon to send the IM you are composing with a high importance indicator.

At the bottom of the message window is a series of icons. The icons are described below.

- **Messages**: Select the Messages (voie) icon to send or view your Lync messages with this contact.
- **Call**: Select the Call (📞) icon to initiate an audio call with this Lync contact.
- **Video**: Select the Video (_video) icon to view a preview of your webcam image and begin sharing your webcam feed.
- **Present**: Select the Present (present) icon to share a file or begin a presentation.
- **Participants**: Select the Participants (👥) icon to view all the participants in this message. Messages can have 2 or more participants.

The last icon on the Message window is the More Options (***️) icon. A pop-up menu displays.

From this menu, you can launch the Recordings Manager by selecting Manage Recordings, or adjust the text display by selecting IM Text Display Size.

Use these icons and options to assist you accomplishing your tasks within Lync.
CHAPTER 5: LYNC OPTIONS MENU

Configuring Lync

Microsoft Lync contains many settings that you may configure to increase the performance and usability of Lync. This topic details accessing the Lync Options menu and how to adjust each setting. The default settings are enabled upon the initial installation of Lync. Follow the steps in this topic to adjust your Lync settings.

To begin, you must open the Options window. From the main Lync window, select the Gear (⚙️) icon, located on the right side of the screen. The Options window displays.

![Lync Options Window](image)

The Options window has 12 configurable areas, displayed on the left side of the screen. By default, the General options are displayed.
The General Settings

The General options provide the ability to configure options related to the way Lync functions. There are four sections within the General options. Configure all four sections, as is appropriate.
Conversation Window Settings
The default settings for this area are shown below. You are not required to change any settings within this area.

If you want emoticons (😊) displayed as images instead of text, select the Show emoticons in messages checkbox.

Next, if you want to use a specific font and font color within Lync, select the Change Font... button. A drop-down menu displays.

- Select the font color you want to use from the palette portion of the drop-down menu.
- Select the name of the font you want to use from the font drop-down menu. You can also adjust the size of the font by selecting a font size from the drop-down menu.
- If you want to apply these font styles to incoming messages, select the Apply settings to incoming messages checkbox. Not selecting this checkbox will only apply your changes to messages you send from within Lync.
- When you are finished making font changes, select the OK button.
Next, the **Enable tabbed conversations** setting is selected by default. This setting provides the ability to collapse multiple message windows into a single window. An example is shown below.

If you do not want your individual messages to be available in a tabbed display, uncheck the **Enable tabbed conversations** checkbox.
If you want the contact's name(s) displayed on a single line within the message window, select the **Make tabs one line only** checkbox. An example of how the message window appears after this setting has been enabled is shown below.

The last setting within the Conversation Windows settings is **Reopen my conversations when I sign in to Lync**. If you use Lync to communicate with the same contacts daily, you might want to have conversation windows open when you log into the Lync.

Proceed to the **Help us improve** settings when you have finished working with the *Conversation Window* settings.
Help Us Improve Settings
The *Help us improve* settings provides the ability to send Microsoft information about how you use Lync and other Microsoft products. By default, *Automatically send Lync error info to Microsoft* is inactive and cannot be selected. There is only one additional setting in this section, as shown below.

The *Sign up for the Customer Experience Improvement Program* checkbox is available for selection. After reading the terms and conditions of the program by selecting the *Learn More* hyperlink, if you want to participate, select the checkbox. Participating in this program is voluntary and at your discretion.

Help Your Support Team Help You Settings
The *Help your support team help you* section of the General Options provides the ability to select the kind of error logging you want to use in Lync and whether or not to log system events.

The *Logging in Lync* option allows you to select the level of detail you want to provide in error logs and troubleshooting information. You can choose one of the three options available in the drop-down menu.

- **Full:** Provides all relevant details pertaining to errors and troubleshooting.
- **Light:** Provides minimal error information related to errors and troubleshooting.
- **Off:** Provides no error or troubleshooting information.

Select the desired option from the drop-down menu.

Also in this section is the *Also turn on Windows Event logging for Lync to collect troubleshooting info* option. This option turns on Windows Event logging for Lync and can...
provide helpful information to support staff in the event you need assistance with Lync. Select this option if you want to enable Windows Event logging for Lync.

Proceed to the Application Window settings when you have finished working with the Help us improve settings.

**Application Window Settings**
The Application Window settings area contains a single configurable option. If you want Lync to minimize to the notification area instead of the task bar when you select the option to minimize the Lync window, select the corresponding checkbox.

This completes the General options configuration. Proceed to the Personal settings option to continue configuring Lync.
The Personal Settings

The Personal settings govern how you want Lync to behave when opened, when your computer starts, and other such settings. The Personal settings are divided into four (4) sections. Configure all four sections, as is appropriate.
CHAPTER 5: LYNC OPTIONS MENU

The My Account Settings

The My account section provides the ability to designate how you want to behave when the program begins running. The My account settings contains three options you may configure.

- **Sign-in address**: Enter your e-mail address in this field. Entering your e-mail address in this field will prevent you from needing to enter your e-mail address each time you log into Lync.

  ![My account settings](image)

  - **Automatically start Lync when I log on to Windows**
  - **Show Lync in the foreground when it starts**

  **NOTE**: The Advanced button within this section is used for internal and external server configuration by technicians and contains no customizable options.

  Next, if you would like Lync to launch when you log into Windows, select the **Automatically start Lync when I log on to Windows** checkbox. This setting saves you from manually launching the application each time you restart Windows.

  The last setting in this section designates where you want the Lync window to display when it launches. If you want Lync to run in the background, uncheck the **Show Lync in the foreground when it starts** checkbox. If you want Lync to run in the foreground, leave this checkbox selected.

  Proceed to the **Personal information manager** settings when you have finished working with the My account settings.
The Personal Information Manager Settings
The *Personal information manager* settings provides the ability to designate how you want Lync to integrate with the Microsoft Exchange Server and/or Microsoft Outlook. You can also designate how you want Lync to save and store IM and call logs.

To begin, verify that **Microsoft Exchange or Microsoft Outlook** is selected and displayed in the drop-down menu. Next, configure the following settings for Lync and Microsoft Exchange/Outlook integration.

- **Update my presence based on my calendar information**: If you would like your Lync status to be automatically updated based on your Outlook Calendar information, leave this checkbox selected. For example, when you are scheduled to be in a meeting, Lync will display your status as Busy for the duration of the scheduled meeting. You can change your status manually, at any time. If you do not want Lync to change your Lync status, deselect this checkbox.

- **Show meeting subject and location to contacts in my Workgroup privacy relationship**: When this setting is enabled, contacts with a privacy relationship of "Workgroup" can see the name of the meeting and the meeting location, when Lync is configured to automatically update your status based on your Microsoft Outlook information. By default, this option is enabled. If you want to disable this setting, deselect the corresponding checkbox.

- **Show my Out of Office info to contacts in my Friends and Family, Workgroup, and Colleagues privacy relationships**: If you want your Out of Office message to be displayed for individuals with a privacy relationship of "Friends and Family," "Workgroup," or "Colleagues," leave this checkbox selected. If you do not want your Out of Office information provided to these contacts, deselect the corresponding checkbox.

If you want your IM conversations to be saved in your email Conversation History folder, leave the **Save IM conversations in my email Conversation History folder** checkbox enabled. Deselect this checkbox to turn this feature off.
CHAPTER 5: LYNC OPTIONS MENU

If you want a log off all calls you send and receive within Lync to be saved in your email Conversation History folder, leave the *Save call logs in my email Conversation History folder* checkbox enabled. Deselect this checkbox to turn this feature off.

Proceed to the *Location* settings when you have finished working with the *Personal information manager* settings.

**The Location Settings**
The *Location* section contains one configurable setting. The *Share my location info with other programs I use* checkbox can be selected if you want your location information to be shared with other programs that you use.

Proceed to the *Show pictures* settings when you have finished working with the *Location* settings.
The Show Pictures Settings

The *Show pictures* section contains one configurable setting. If you want to view the profile pictures of your contacts within Lync, leave this checkbox enabled. If you do not want to view contact pictures, deselect the *Show pictures of contacts* checkbox. However, if you disable the displaying of profile pictures, your own profile pictures is disabled from being viewed.

![Show pictures settings](image)

This completes the *Personal* options configuration. Proceed to the *Contacts List* settings option to continue configuring Lync.
The Contacts List Settings

The *Contacts List* settings govern how you want Lync to behave when opened, when your computer starts, and other such settings. The *Contact List* settings are divided into three (3) sections. Configure all three sections, as is appropriate.
My Contacts List Settings
The My Contacts list section provides the ability to designate how you want contacts to be displayed on your Contact List. You can elect to display your contacts with their name and picture, or just their name. Select the radio button that is adjacent to the option you want to use.

Proceed to the Order my list settings when you have finished working with the My Contacts List settings.

Order My List Settings
The Order my list settings provide the ability to designate how you want contacts to be ordered within your Contact List. You can elect to order your contacts with their name or by their availability. Select the radio button that is adjacent to the option you want to use.

Proceed to the Show this information settings when you have finished working with the Order my list settings.
Show This Information Settings

The Show this information section provides the ability to designate what information about your contacts is displayed within your Lync Contact List. Select which, if any, of the following option you want to utilize.

- **Contact name (instead of email address):** If you want to display your contacts by their names instead of their e-mail addresses, leave this checkbox selected. If you want your contacts displayed by their e-mail address, deselect the corresponding checkbox.

- **Contact status:** Select this option if you want to view the status (Away, Busy, etc.) of your contacts. Deselect the corresponding checkbox if you do not want to view their status.

- **Show contacts with away, offline and unknown presences in a separate group:** If you want contacts with one of these statuses to be placed into a special group, leave this option selected. If you do not want to use this option, deselect the checkbox.

- **Favorites group:** If you want to make use of a Favorites group, leave this option selected. If you do not want to use a Favorites group, deselect this option.

This completes the Contact List options configuration. Proceed to the Status settings option to continue configuring Lync.
The Status Settings
The Status settings provide the ability to designate how Lync displays your status, in specific scenarios. Select the appropriate settings, based on your preferences.
The Status settings contain the following options.

- **Show me as Inactive when my computer has been idle for this many minutes**: You can designate how long you can be idle (your computer is on and logged in, but is unattended) before Lync changes your status to reflect you are idle. You can select any time interval between 5 and 360 minutes. It is recommended that you do not use a time interval of less than 5 minutes. Use the up and downward pointing arrows to increase and decrease the time displayed. You may also directly enter the number of minutes by typing the desired length.

- **Change my status from Inactive to Away after this many minutes**: After a certain amount of time, you will want Lync to change your Inactive status to Away, to alert your contacts that you are not present at this moment. You can designate how long you can be inactive before Lync changes your status to Away. You can select any time interval between 5 and 360 minutes. It is recommended that you do not use a time interval of less than 5 minutes. Use the up and downward pointing arrows to increase and decrease the time displayed. You may also directly enter the number of minutes by typing the desired length.

- **I want everyone to be able to see my presence regardless of system settings (override default settings)**: This option and the next option are related. If you want everyone using Lync to be able to see your online presence, regardless of the system settings, select this radio button.

- **I want the system administrator to decide - currently everyone can see my presence but this could change in the future**: This option is related to the previous option. If you want the system administrator to decide how and when Lync users see your online presence, select this radio button.

- **Show me as Do Not Disturb when I present my desktop**: When you are sharing your screen or desktop with Lync contacts, Lync can automatically change your status to Do Not Disturb, so that messages will not be received during this time. Select this option to enable this feature.

- **Show me as Do Not Disturb when my monitor is duplicated**: When you are using your computer in conjunction with a projector or other duplication device, Lync can automatically change your status to Do Not Disturb, so that messages will not be received during this time. Select this option to enable this feature.

This completes the Status options configuration. Proceed to the **My Picture** settings option to continue configuring Lync.
My Picture Settings
The My picture settings provide the ability to show or hide your profile picture. If you select the **Hide my picture** option, your picture will not display in Lync (though it may display other places, depending upon your configuration). If you select the **Show my picture** option, your profile picture is displayed to your contacts.
Edit or Remove Picture
By selecting the **Edit or Remove Picture** button, you can select a new profile picture to display, or remove your profile picture altogether.

Select the **Edit or Remove Picture** button. A browser window launches and you will received a user name and password prompt, similar to the following.

![Authentication Required](image)

Enter your USC e-mail address in the *User Name* field. Next, enter your corresponding password and then select the **OK** button. The *Account Information* page displays.

![Account Information](image)
Select the black X ( ✗ ) to remove your photo. Select the Browse... button to locate a local image that you want to display as your profile picture. This picture is connected to your Microsoft Outlook profile, so you will want to select an appropriate image.

After you have selected an image to use as your profile picture, select the Save button, located at the bottom right side of the screen.

Lync now displays the image you selected as your profile picture. It may take a few minutes for your contacts to be able to see the new picture.

This completes the My Picture options configuration. Proceed to the Phones settings option to continue configuring Lync.
The Phones Settings
The *Phone* settings provides the ability to configure information related to telephones and placing calls. This screen is divided into four (4) sections. Configure all four sections, as is appropriate.
My Phone Numbers Settings
The My phone numbers section provides the ability to add or edit the numbers associated with your profile.

The Work Phone... field is supplied by payroll and HR records and cannot be edited within Lync. The Mobile, Home, and Other Phone... fields can be edited. Select the button associated with the number you want to configure. The Edit Phone Number screen displays.
Enter the phone number you want to add and then select the OK button. The phone number entered is now displayed in the My phone numbers section.

![My phone numbers section]

Proceed to the Phone integration settings when you have finished working with the My phone numbers settings.

**The Phone Integration Settings**

The Phone integration section contains one option. This option is not currently supported and, therefore, is not available to be configured.

![Phone integration section]

Proceed to the Phone Accessibility settings when you have finished working with the Phone integration settings.
CHAPTER 5: LYNC OPTIONS MENU

The Phone Accessibility Settings
The *Phone accessibility* section provides the ability to use TTY to communicate via text over a telephone line. TTY is commonly used in devices made for the hearing impaired, and translates telephone conversations into readable text, much like Closed Captioning in television programs.

If you want to enable TTY, select the **Turn on TTY mode** checkbox.

Proceed to the **Join conference calls** settings when you have finished working with the *Phone Accessibility* settings.

The Join Conference Calls Settings
The *Join conference calls* section provides the ability to select where audio is capture from when you join a conference call in Lync. There are two (2) configurable options within this section.

- **Join meeting audio from**: Select the drop-down menu to select from where you want meeting audio to originate. An example of how the drop-down menu may appear is displayed below.

  ![Join meeting audio from example](image)

- **Before I join meetings, ask me which audio device I want to use**: If you want to select which audio device to use when you join a conference call that utilizes Lync resources.

This completes the *Phones* options configuration. Proceed to the *Alerts* settings option to continue configuring Lync.
The Alerts Settings
The Alerts settings provides the ability to configure when alerts are received. This screen is divided into three (3) sections. Configure all three sections, as is appropriate.
CHAPTER 5: LYNC OPTIONS MENU

The General Alerts Settings
The *General alerts* section provides the ability to designate whether or not you want to receive an alert when a person adds you to their Contact List.

Select the *Tell me when someone adds me to his or her contact list* option to enable this feature.

Proceed to the *When my status is Do Not Disturb* settings when you have finished working with the *General alerts* settings.

The When my status is Do Not Disturb Settings
This section of the *Alerts* settings corresponds to how you want Lync to behave when your status is set to *Do Not Disturb*.

Select the radio button that corresponds to the option you want to use.

- Don't show alerts
- Show only conversation alerts from people in my Workgroup privacy relationship
- Show all alerts, but only conversation alerts from people in my Workgroup privacy relationship

Proceed to the *Contacts not using Lync* settings when you have finished working with the *When my status is Do Not Disturb* settings.
The Contacts Not Using Lync Settings
This section of the Alerts settings corresponds to how you want Lync to behave regarding contacts that are not using Lync.

Select one of these options to indicate how you want Lync to address non-Lync users adding you to their Contact List.

- Block all invites and communications
- Allow invites but block all other communications
- Allow anyone to contact me

By default, the Allow invites from domains my admin hasn't verified (You'll only hear from people in these domains if they're on your Contacts list.) option is enabled. If you want to disable this option, deselect the corresponding checkbox.

This completes the Alerts options configuration. Proceed to the Ringtones and Sounds settings option to continue configuring Lync.
CHAPTER 5: LYNC OPTIONS MENU

The Ringtones and Sounds Settings
The *Ringtones and Sounds* settings provides the ability to configure when a sound alert plays and which sound alert plays. This screen is divided into two (2) sections. Configure both sections, as is appropriate.

The Ringtones Settings
To set the ringtone that will play with a specific phone number, select the phone number in the *Calls to:* column (in this example, the label is *My work number*). Then, select the an item from the *Ringtone:* column. As a sound file is select in the *Ringtone:* column, the sound will play. When an item in both columns is selected, you are finish working with the *Ringtone* settings.
The Sounds Settings
The Sounds section contains the settings that govern when a sound will play within Lync.

Select one or more of the checkboxes within this section to enable the setting.

- Play sounds in Lync (including ringtones for incoming calls and IM alerts)
- Mute incoming IM alert sounds when viewing an IM conversation
- Keep sounds to a minimum when my status is Busy
- Keep sounds to a minimum when my status is Do Not Disturb

The Play music on hold option is disabled by default because this feature is not currently supported.
At the bottom of this section is the **Sound Settings** button. Selecting this button opens the Windows Sound menu. From this menu, you can preview and change the sounds that Lync will play when an action occurs.

Using the scroll bar, locate the **Lync** sounds in the list. Highlight the name of a sound. The **Sounds** field displays the name of the sound file and the **Test** button becomes available. To hear the current sound file, select the **Test** button. To choose a different sound, select the **Browse...** button and locate the sound file you would like to use for the selected event.

When you have finished reviewing and editing the Lync sounds, select the **OK** button to save your changes and exit the **Sounds** window.

This completes the **Ringtones and Sounds** options configuration. Proceed to the **Audio Device** settings option to continue configuring Lync.
The Audio Device Settings

The *Audio Device* settings provides the ability to configure speaker and audio-related options. This screen is divided into three (3) sections. Configure all three sections, as is appropriate.
The Audio Device Settings

The *Audio device* section provides the ability to select which speakers, microphone, and ringer are used in Lync.

First, **Select the device you want to use for audio calls** by selecting the drop-down menu associated with this setting. If you only have one microphone and one speaker associated with your computer, the system defaults will be the only option available in this menu. If you have more than one microphone and/or speaker, select the name of the device you want to use with audio calls, from the drop-down menu.

Under **Customize your device**, you can select which speaker and microphone you want to use with Lync when not related to an audio call. Select the corresponding drop-down menu to select a speaker or microphone for use with Lync. Underneath the **Microphone** drop-down menu, a sound indicator is displayed. When your microphone is registering sound, the indicator displays that the sound is being detected.

The **Ringer** option provides the ability to play the sound associated with an incoming audio call within Lync. This sound cannot be changed on this screen. Go to the *Ringtones and Sounds* settings to edit the **Ringer** sound file.

Proceed to the **Secondary ringer** settings when you have finished working with the **Audio device** settings.
CHAPTER 5: LYNC OPTIONS MENU

The Secondary Ringer Settings
The Secondary Ringer settings are not currently supported and are disabled. This section contains no configurable options. Proceed to the Stereo Audio Playback settings.

<table>
<thead>
<tr>
<th>Secondary ringer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Also ring:</td>
</tr>
<tr>
<td>Unmute when my phone rings</td>
</tr>
</tbody>
</table>

The Stereo Audio Feedback Settings
The Stereo audio playback section contains one configurable option. You can select the Allow stereo audio playback when available option to allow a higher audio quality, when available. Deselect this option to disable this option.

<table>
<thead>
<tr>
<th>Stereo audio playback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow stereo audio playback when available</td>
</tr>
</tbody>
</table>

This completes the Audio Device options configuration. Proceed to the Video Device settings option to continue configuring Lync.
The Video Device Settings
The Video Device settings provides the ability to configure webcam-related options. This screen is divided into two (2) sections. Configure both sections, as is appropriate.
The Video Device Settings

The *video device* settings section provides the ability to select the webcam you want to use with Lync.

If you have multiple webcams attached to your computer, you can select which one you would like to use with Lync. Select the drop-down menu and choose the name of the webcam you want to use with Lync. If the webcam is functioning correctly, a preview image of the webcam's feed is displayed in the black square in the center of the section.
If the image being displayed by the webcam needs to be adjusted, select the **Camera Settings** button. The *Properties* window displays.

Adjust the settings as is appropriate. When you have finished adjusting the camera settings, select the **OK** button to save your changes.
Proceed to the Video Settings options when you have finished working with the Video device settings.

**The Video Settings**

The Video settings section contains one configurable option. You can select the Crop and center my video meetings option if you want your video feed to be cropped and centered within Lync meetings. Deselect this option to turn this feature off.

![Video settings](image)

This completes the Video Device options configuration. Proceed to the File Saving settings option to continue configuring Lync.
The File Saving Settings

The *File Saving* settings contains one configurable option. You can select the location to which you want to save files that are received through Lync. You can use the default location, or, select the **Browse...** button and choose a new location to which all files received within Lync will be saved.

This completes the *File Sharing* options configuration. Proceed to the *Recordings* settings option to continue configuring Lync.
The Recordings Settings
The *Recording* settings provides two configurable options related to recordings within Lync.

![Lync Recordings Settings](Image)

**The Lync Recordings Setting**
The *Lync recordings* settings provide the ability to select the location to which recordings made within Lync will be saved.

![Lync Recordings Settings](Image)

The default location is displayed in the *Save to:* field (this location may vary). To select a new location to which you want to save your recordings, select the *Browse*... button. Select the new location. When you are finished, select the *OK* button. The new location is displayed in the *Save to:* field.

When you are finished adjusting the save location for Lync recordings, proceed to the *Image resolution* settings.
The Image Resolution Settings
In this section, you have the ability to select the resolution of images/recordings within Lync. The higher the resolution, the better the image quality. However, a higher resolution imaging can slow down your Internet connection speed.

Select the radio button next to the resolution you want to use.

This completes the Recordings options configuration. Proceed to the Lync Meetings settings option to continue configuring Lync.
The Lync Meetings Settings
The *Lync Meetings* settings provides the ability to configure meeting-related options. This screen is divided into two (2) sections. Configure both sections, as is appropriate.

![Lync Meetings Settings](image)

The **When I Join Meetings Setting**
The When I join meetings settings inform Lync what actions you want taken in specific instances. In this section, you can select decide how Lync should behave when you have joined a meeting.

- **Show IM**: Select this setting if you would like the IM portion of the meeting room displayed when you join a meeting.
- **Show the participant list**: Select this setting if you want the meeting participant list displayed.

After you have finished configuring these settings, proceed to the *Meeting default* settings.
The Meeting Default Settings

The *Meeting default* section contains one configurable option. If you have multiple versions of Lync installed, you can select which version you want to use for meetings. Select the Change... button.

Select the version of Lync you want to use with meetings. The OK button is now active. Select OK. The default version of Lync for meetings is now set.

The Lync Settings configuration is now complete. Select the OK button at the bottom of the screen to save your changes.
When using the presentation functionality, Microsoft Lync provides you with many options to be able to conduct sharing sessions effectively.

**Presentation Tools**

After launching your meeting session, select the Present ( ) icon. The Presentation Tools menu displays.

![Presentation Tools Menu](image)
This screen provides the ability to select what you want to be shared during your presentation session. You can select from the following options, within the Present area of the menu.

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Monitors</td>
<td>Select this option if you have more than one monitor connected to your computer system and you want to share content from multiple monitors.</td>
</tr>
<tr>
<td>Primary Monitor</td>
<td>Select this option if you have multiple monitors connected to your system and you want to share content that is displayed on the primary monitor only.</td>
</tr>
<tr>
<td>Secondary Monitor</td>
<td>Select this option if you have multiple monitors connected to your system and you want to share content that is displayed on the secondary monitor only.</td>
</tr>
<tr>
<td>Program</td>
<td>Select this option if you want to share a specific program only. Participants will not be able to see any other information or programs that are currently running on your computer.</td>
</tr>
<tr>
<td>PowerPoint</td>
<td>Select this option if you want to share a PowerPoint presentation file.</td>
</tr>
<tr>
<td>Whiteboard</td>
<td>Select this option if you want to use the Whiteboard functionality.</td>
</tr>
<tr>
<td>Poll</td>
<td>If you want to conduct an anonymous poll with the individuals in your meeting, this option provides the ability to create and administer a poll.</td>
</tr>
<tr>
<td>Q &amp; A</td>
<td>If you want to conduct a Q &amp; A session with the individuals in your meeting, this option provides the ability to conduct that session.</td>
</tr>
</tbody>
</table>

Additionally, you can select the ONENOTE or ATTACHMENTS area to share OneNote files, or other, non-specified attachments.
Using the Whiteboard

Using the Whiteboard functionality within Lync is simple and effective. The Whiteboard provides the ability for all participants to interact with communication tools to brainstorm ideas or work through concepts.
CHAPTER 6: PRESENTATION TOOLS WITHIN LYNC

On the right side of the Whiteboard, you can select which tool you want to use on the Whiteboard. Select from one of the following options.

<table>
<thead>
<tr>
<th>Option Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Laser Pointer</td>
<td>Select the Laser Pointer tool to use a laser pointer to draw your attendees attention to an item or area on the Whiteboard.</td>
</tr>
<tr>
<td>Text</td>
<td>Select the Text tool to insert a text area on the Whiteboard. Use the drop-down menu to adjust the color and size of the text.</td>
</tr>
<tr>
<td>Pen</td>
<td>Select the Pen tool to write on an area of the Whiteboard. Use the drop-down menu to adjust the color and size of the writing.</td>
</tr>
<tr>
<td>Highlighter</td>
<td>Select the Highlighter tool to highlight on an area of the Whiteboard. Use the drop-down menu to adjust the color and size of the highlighting.</td>
</tr>
<tr>
<td>Eraser</td>
<td>Select the Eraser tool to remove an object on an area of the Whiteboard.</td>
</tr>
<tr>
<td>Stamp</td>
<td>Select the Stamp tool to place a checkmark or an X on an area of the Whiteboard. Use the drop-down menu to select a specific stamp.</td>
</tr>
<tr>
<td>Shape</td>
<td>Select the Shape tool to draw a shape on an area of the Whiteboard. Use the drop-down menu to adjust the color, size, and shape of the drawn.</td>
</tr>
<tr>
<td>Delete Annotations</td>
<td>Select the Delete Annotations tool to remove a text area of the Whiteboard.</td>
</tr>
<tr>
<td>More Options</td>
<td>Select the More Options tools to display a traditional Windows menu, containing such options as Copy, Paste, and Save As.</td>
</tr>
</tbody>
</table>

Use these tools in conjunction with the Whiteboard to make the best use of Lync and its resources.
Creating a Poll

During your sharing session, you may want to create a poll to gain a response from your participants. Lync provides the option to create a poll. Select **Presentation > Poll**. A screen similar to the following appears.

![Create a Poll](image_url)
CHAPTER 6: PRESENTATION TOOLS WITHIN LYNC

Enter a name for the poll, the question, and the poll choices. When you have finished entering these items, select the **Create** button. The poll is placed into the Lync presentation area.

You can configure whether or not to allow participants to see the poll results, close the poll, and other actions, by selecting the **Poll Actions** menu.
The Lync Recording Manager is a component of Lync that assists in the management of recording files. To launch the Recording Manager, select **Tools > Recording Manager**.

The **Recording Manager** displays.
The Recording Manager displays a list of all the recordings you have made in Lync, which you have not delete. From the Recording Manager you can:

- **Play**: View a recording
- **Browse**: Locate and open a recorded file
- **Publish**: Save a copy of a recorded file to a different location
- **Rename**: Rename a recorded file
- **Delete**: Delete a recorded file from your computer by highlighting the name of the file and selecting the **Delete** button

Use the Recording Manager to assist you in the management of recorded files from Lync.
CONTACT DORNSIFE TECHNOLOGY SERVICES

Campus Office:
825 Bloom Walk, ACB 530
Los Angeles, CA 90089-1486

Technical Support: 213-740-2775
E-mail: ts@dornsife.usc.edu